Introduction

The Interactive Forecast Program (IFP) uses the hydrologic physical process modeling of the Operational Forecast System (OFS) combined with a graphical user interface to provide:

- the information needed to make decisions about the correctness of data or model results and
- the capability to easily and quickly put those decisions into action to produce forecasts reflecting their best judgement about current and future hydrometeorologic conditions

There are two main applications which make up IFP:

- IFP_Map consists of a geographic display which allows the user to choose the subarea and time period for which to run the OFS. This display and its associated menu system allow for control of the sequence of OFS runs and provides different display options.

- ifp_nwsrfs performs the hydrologic computations, displays the model results and allows the user to interactively make model adjustments as needed. It is called automatically from IFP_Map when appropriate.

The user interacts with the OFS through IFP using point and select actions in numerous windows that are displayed during an IFP session.

Typical Run Sequence

The following briefly describes a typical run sequence and presents some of the windows one would encounter.

A typical IFP session begins with choosing a time period and a subset of forecast points (Forecast Group) with which to work (Figure 1a [Bookmark] and Figure 1b [Bookmark]). The data is loaded and the geographic display zooms in on the selected Forecast Group (Figure 2 [Bookmark]). In addition a schematic showing how the forecast points are hydrologically connected is displayed (Figure 3 [Bookmark]). Both the schematic and geographic display are color coded to show an overview of the current hydrologic conditions.
To make a forecast run using the default options, the user selects **Begin** from the **File** menu (Figure 4 [Bookmark]) which runs the hydrologic models for the most upstream forecast point (Figure 5 [Bookmark]) and the results are displayed (Figure 6 [Bookmark]). At this point, changes can be made to certain input data and parameters then rerun the current forecast point or continue on to another forecast point. This process is repeated until the user is satisfied with the forecasts for the forecast point in that area.

**Overview**

The rest of this document steps for using IFP to provide guidance for river and flood forecasts including the use of many of the options.

IFP provides everything necessary to run the hydrologic component of the OFS interactively and was designed to help in the process of creating run time modifications (MODs).

IFP uses the Forecast Group as the basic unit for modeling the rainfall runoff process. A Forecast Group is a drainage basin that is comprised of contiguous, topologically connected sub-basins (called forecast points or Segments). It is at the sub-basin scale that the hydrologic models are applied.

Interactive hydrologic modeling takes place within Segments where the models can be run, adjustments to model parameters can be made and the models can be rerun for the current sub-basin. The process of running, making parameters changes and rerunning the models for a particular Segment continues until the user is satisfied with agreement between the observed and simulated flows. These flows are input to the next downstream sub-basin. Inflows from upstream Segments are routed through a downstream Segment using one of the routing Operations and are combined with each other and any local runoff.

Operations define the hydrologic models that are used within every Segment. The choice of which routing Operation to use, as well as any other Operation, is made well in advance of using IFP. The Forecast Group topology, Segment definitions, selection of hydrologic Operations for each Segment, etc., are created using the OFS file initialization programs PPINIT and FCINIT. Program FCINIT is used when a Forecast Group is created changes need to be made to a Forecast Group such as adding, removing or combining Segments or changing the Operations used within a Segment.

**Starting an IFP Run**

Two windows initially appear when an IFP_Map run is started; one is a geographic display of the area; the other shows all the Forecast Groups that are in Carryover Groups (Figure 7 [Bookmark]).
When a Forecast Group is selected the carryover dates available appear in the right-hand column (Figure 8 [Bookmark#1]).

There are two available choices for the source of data for an IFP session:

1. making a copy of the operational set of files in the user's home directory
2. using the copy of files already in the user's home directory (Figure 9 [Bookmark#1])

There will be times when you want to choose each of these sources. Initially (the first time the Forecast Group is run), you must get all data from the operational file set. This includes parametric, Rating Curve, Segment connectivity, Operations Table and HCL default values; as well as current carryover, time series and run time MOD data. You should only have to make this type of transfer to get the most recent data to run a Forecast Group or whenever any parametric, Segment connectivity, Rating Curve or HCL default information changes on the operational files.

The second choice is to get all the data for the current session from the copy currently in the user's home directory. This will not reflect any changes that may have been made to time series, carryover or run-time MODs on the operational files since the user's last IFP session. This choice is significantly faster to start up than the other because the OFS files do not have to be copied, but be warned that you will be missing any recent changes that occurred on the operational set of files.

In addition to the Forecast Group and data source, you must also select a date to begin the forecast run. The available dates of carryover are displayed in the right-hand column and can be selected to determine the start date of the run (Figure 9 [Bookmark#2]). Again be warned that if you chose the Use previous IFP option, all the dates shown may not be available. The forecast component will find an alternate date of carryover if the one you chose is not in the user's copy of the files and change the start of run date accordingly.

Online help is available for IFP. An example of the help for selecting a Forecast Group and carryover date can be seen here in Figure 10 [Bookmark#1]. There are 3 ways to access help about a topic:

1. highlight a word or phrase in the top panel then click on the Find button to create a list of the topics that contain that word or phrase
2. click on the topic of interest from the list in the middle panel
3. type in the word or phrase in the bottom panel then click Find

In addition to help available by selection Help buttons, context-sensitive help is in many menus and displays in the IFP. This help should tell the user what will happen if they select the button at which they are currently pointing. The user could see the (Figure 10 [Bookmark#2]) following message by holding the left control key and...
moving the mouse over the Load button (Figure 11 [Bookmark]).

When Load is selected, data is read from the chosen data source for the desired Forecast Group and carryover date. Depending on the data source and the size of the Forecast Group chosen, this may take some time. It can be seconds for getting data from the user's own copy of files, to several minutes to copy all the data from the OFS files. A pop-up message indicates that the data is being retrieved (Figure 12 [Bookmark]).

IFP Map - Initial Displays

After the data is loaded and the geographic display zooms in on the selected Forecast Group (Figure 2). In addition a schematic showing how the forecast points are hydrologically connected is displayed (Figure 3). Both the schematic and geographic display are color coded to show an overview of the current hydrologic conditions.

In the schematic the small boxes with forecast point names in them represent the individual Segments in the Forecast Group. The lines connecting the boxes show stream connectivity. Water flows from left to right in the schematic. Forecast points immediately up or downstream of the forecast point are also shown in this schematic to help orient the user and provide information about connectivity among Forecast Groups.

The color of a forecast point box represents its current flow condition. Green indicates a normal flow condition, near bankfull or alert conditions are indicated by a yellow color and flood conditions are shown in red. If there is no Rating Curve for a Segment, its flow condition cannot be determined and it is shown in gray. The same color scheme is used in the geographic display for the basin outlines.

IFP Map Menu System - Controlling IFP Displays and the OFS Run

After selecting the Forecast Group and start of run date in the initial window, a user can run the hydrologic modeling system. The models used in IFP are the same as those used in the Calibration System and the Operational Forecast System. The capabilities available in IFP are the color graphical display of much of the information now presented as printer output and the ability of a user to make adjustments through IFP graphical user interface.

To produce a graphical plot of the model outputs and observed data, a user must select **Begin** in the IFP Map **File** menu (Figure 13 [Bookmark#1]). This will run the Forecast Component using default settings for a number of options which are described in the following pages and produce a plot of the resulting hydrographs (Figure 14 [Bookmark#1]). With this one point-and-select (Figure 13 [Bookmark#2] and Figure 14 [Bookmark#2]) action a user can be running. The rest of this document describes the various options which are available to see
and adjust components of the river forecasting system.

The IFP_Map menu bar has several pull-down menus. These are for the control and display of the many features available.

The File menu has seven entries to control the flow of the IFP_Map program (Figure 13 [Bookmark#3]). At various times during the run, different items will be dark and sensitive (able to be selected) while others will be grayed out and insensitive (not selectable). When the application starts, the only two valid choices in the Control menu are to Begin a run and to Quit. During the processing of forecast points, the other choices will become sensitive. The choices are:

1. to Begin a forecast run
2. to Rerun the current forecast point to cause any run time MODs to take effect
3. to run the Next downstream forecast point
4. to Continue to another Tulsa plot or Plot-TS plot in the current Segment
5. to Go to a selected segment either up or downstream of the current one
6. to choose a New Forecast Group to work with
7. to Quit the IFP_Map application

There are letters to the right of the command name on many of the choices in this pull-down menu. These accelerator keys can activate the selection without pointing and clicking with the mouse. When keyboard input is focused to the IFP_Map window (i.e., its border is highlighted) the action in a pull-down menu can be obtained by holding down the control (Ctrl) key while pressing the appropriate letter key. These accelerators also appear on most other pull-down menus.

The Options menu (Figure 15 [Bookmark#1]) allows the user to set a number of options prior to the start of hydrologic computations. The ten items in the menus let the user keep a group of Segments selected by clicking on the small boxes with the Segment names in the main IFP_Map schematic. When a forecast point is selected, all Segments upstream of that point are (Figure 15 [Bookmark#2]) also selected. This ensures that IFP always works with a connected tree structure of forecast points. After points are selected the options are:

1. Keep them as noted above
2. Delete them from the current run or:
3. Reset to be unselected

These three Options menu subcommands may be repeated to obtain the desired set of forecast points for the current run. When Begin is selected in the File menu, the hydrologic computations start. If:

4. Single segment when Begin appears in the Options menu (the default)

then the first Segment at the top of the run Segments list will be executed and a hydrograph plot will be displayed. If this menu item is selected, the text displayed in the menu changes to Go to segment when Begin the meaning of a selection in the schematic or map Forecast Group windows changes. A selection in either of these windows will now choose the Segment at which a hydrograph plot will first be displayed when Begin is selected from the File menu. Hydrologic computations will be performed for all Segments upstream of the chosen
5. **Revert to original Forecast Group topology**

option could be invoked if, after some deletions of forecast points from the original Forecast Group schematic, the user decided that too many had been removed. This would rebuild and display the original tree.

6. **Revert to original map view**

option results in the geographic display returning to the view of the whole area from the zoomed in view of an individual Forecast Group.

7. **Set dates...**

option will pop up a window which allows the end of observations and end dates to be changed (Figure 16 [Bookmark]). Note that the start date was specified by the carryover date selected in the Select Forecast Group and Carryover Date window at the start of the IFP_Map run (Figure 8 [Bookmark#2]). A date can be changed by selecting on any of the month, day, year or hour text boxes, changing the value by selecting with the arrow buttons or typing the date in the text boxes.

8. **Tools**

option brings up a panel of tools that can be used in association with the geographic display (Figure 17 [Bookmark]). These tools put the cursor in different modes to get different kinds of information or take actions. There are tools for:

- putting the cursor in standard pointer mode
- selecting a rectangular area of the geographic display
- displaying the latitude, longitude position of the cursor in the display
- displaying E19 information about a forecast point (described below)
- finding the radius of a circle drawn on the display
- displaying the distance of a line drawn by the cursor on the display
- zooming out to the next higher level and
- zooming into the area outlined with the select tool

As an example in the use of these tools, static or non time dependent information about each forecast point can be seen by first selecting the '?' tool then selecting the basin of interest in the geographic display. An information pop-up appears with data obtained from the OFS Rating Curve file (Figure 18 [Bookmark]). This 'E19' type data typically gives the forecast point description, latitude, longitude, area and various flood, alert and flood of record information.

9. **Preferences**

button has a submenu that will allow one to bring up a display to make some color choices for parts of the IFP_Map display. The

10. **Techniques**

option (Figure 19 [Bookmark]) allows the user to set Universal and Nonuniversal Techniques which control numerous options in the hydrologic models. The Universal Techniques apply throughout the run while Nonuniversal Techniques can be changed for any forecast point.

The **Universal** Techniques window allows the user to change time zone,
units and other Operations (Figure 20 [Bookmark]). Time zones may by
changed by selecting and holding on the current setting and then
moving the mouse to the desired setting before release (Figure 21
[Bookmark]). Units toggle between English and metric. The Sacramento
SMA model units for run time MODs is being changed to metric. In
addition, the choice of using forecast or zero precipitation beyond
the end of the observed data period can be set, as well as whether or
not to print warning messages from run time MODs.

The Nonuniversal Techniques window allows the user to set Techniques
used to control the snow model, the frozen ground option of the
Sacramento SMA model, UPSC, UPWE and the Sacramento/snow state display
(Figure 22 [Bookmark]). These options can be turned on or off for all
forecast points in the current run or can be changed for selected
points.

The Display menu (Figure 23 [Bookmark#1]) has the following options:
1. display the forecast points that have been deleted (Deleted
   segments)
2. display the forecast points in the run (Run segments)
3. display the Operations Table
4. display the Rating curve for the current Segment if available
5. display the Forecast Group topology
6. display the Current Run-time MODs
7. Save GIF File
8. select geographic overlays to be displayed using Geography
   (Figure 24 [Bookmark])

When the SAC/SNOW STATE Technique is turned on in the Non-universal
Techniques window then:
9. display the SAC plot (Figure 45 [Bookmark#1])
10. Display the SNOW plot (Figure 46 [Bookmark#1])

The Modifications menu (Figure 25 [Bookmark]), which becomes sensitive
while processing the hydrologic computations for a forecast point,
allows the user to display or hide windows for the:
1. graphical Tulsa plot
2. Time-Series table tabular data
3. graphical TS-Plot
4. Other MODs
5. Mods viewer

The Help menu item in this and many other windows gives online
information about how to obtain further help if you are at a loss for
what to do next (Figure 10 [Bookmark#3]). Context-sensitive help is
used extensively throughout IFP to remind a user of the purpose of a
particular menu item. Here context-sensitive help for the
Modifications menu item is shown (Figure 26 [Bookmark]).

Run Preparation - Before Begin

To remove some forecast points from the current IFP run (Figure 27
[Bookmark]), the user selects a forecast point in the IFP_Map
schematic window. The selected point and all points upstream are highlighted (Figure 28 [Bookmark]).

These selected points may now be kept, deleted or reset to unselected. The top three buttons in the Options menu have become sensitive indicating that Segments have been selected to be acted upon. By selecting Delete in the Options menu, the Forecast Group schematic will be changed to reflect that now only a subset of the original group will be run.

The Forecast Run - Selected Options

A forecast run is started by selecting Begin in the File menu (Figure 29 [Bookmark]). The Operations Table for the appropriate Segments are run until a Tulsa plot Operation is found, at which time a graphical Tulsa plot (Figure 30 [Bookmark]) or a Plot-TS plot is displayed. The Tulsa plot display contains three main plot areas. The top area is a plot of the precipitation time series (MAP or RAIM). Digital information about the time and time series value may be obtained by selecting and holding the left mouse button while in the precipitation plot area. Cross-hair appear on the window and a numeric display of the X and Y coordinates of the mouse are shown in units of time and time series value (Figure 31 [Bookmark]). The middle plot is a plot of the runoff time series (INFW) (Figure 32 [Bookmark]) and the bottom plot is the plot of the hydrographs (Figure 33 [Bookmark]). Holding the left mouse button in any of these plots will bring up the cross-hair and associated information for the appropriate plot. The Plot-TS plot (Figure 47a [Bookmark]) can display a maximum of 6 plots and 10 time series on each plot. Each plot has one Change Y-Scale button (Figure 47b [Bookmark]) and one or more time series button.

The following section describes the various additional displays that can be viewed and the options available for making run time modifications.

Now that the hydrologic computations have begun, the Display menu has changed to become sensitive to show the Operations Table and if applicable, the Rating Curve (Figure 23 [Bookmark]). Selecting Rating curve causes the Rating Curve associated with the current Tulsa plot to be plotted (Figure 34 [Bookmark]). In addition to the general shape of the Rating Curve, information about specific point values can be obtained by holding the left mouse button as described above for the plots in the Tulsa plot display.

Selecting on the Operations table button in the Display menu causes a window to appear which lists all Operations for the current Segment Operations Table (Figure 35 [Bookmark]). Selecting an Operation in the list and then selecting Show in the Operations Table window will pop up a window with text output the same as the program FCINIT command PRINTSEGS. The parameters and carryover for the current Sacramento SMA model are shown in Figure 36 [Bookmark].
Time Series Change Run-Time Modifications

Time series which are displayed on the Tulsa plot may be changed by selecting on the name of the time series in the Tulsa plot legend. This will cause all other legend items to dim and the selected series to turn white on the plot.

New values can be entered by selecting and holding with the mouse and moving to the desired value. Temporary lines will move with the mouse (Figure 34 [Bookmark#2]) during value entry to help aid the user to see the shape of the newly entered values (Figure 37 [Bookmark]).

When changes are complete, the user selects again on the time series legend button to record the changes (Figure 38 [Bookmark]). These changes can be removed by again selecting the time series legend button and then selecting the undo time series change button (Figure 39 [Bookmark]).

Time series changes can also be made in the tabular display window. The user first selects the cell in the table to change and edits the value. Pressing Enter after changes have been made will cause the new value to display in red in the table. Values changed in the table for time series that are plotted will also change the plotted values (Figure 40 [Bookmark]). When plotted, time series which are also tabulated are changed in the plot, their new values appear as red in the table window.

When a time series change MOD is made a keyword indicating where in the processing of the Operations Table the MOD will occur is needed. When the user selects Rerun and a time series change MOD has been entered, a window to select keywords will pop up (Figure 41 [Bookmark]). The user must either use the defaults provided, where available or select before which Operations the MOD will be applied. The defaults are to specify First (before first Operation) for input time series, the current Tulsa plot for output time series and no default for internal time series. The user will know when an acceptable keyword has been chosen because a check will appear to the left of the time series name. The Rerun command can proceed only when all time series are checked.

Other Run-Time Modifications

Starting the hydrologic computations also makes the entries in the Modifications menu sensitive (Figure 42 [Bookmark]). The Tulsa plot and tabular data window may be visible or hidden at the user preference.

Selecting Other Mods displays the Mods for window. This window has the following options:

1. Available Operations
2. Available Run-time Mods
3. Mod Value
4. Operations/Time-series
5. **Mod Dates**
6. **Time-series Dates**
7. **Options**
8. **Display**
9. **Create**
10. **Close**
11. **Undo**
12. **Preferences**
13. **Help**

The **Available Operations** panel has a list of Operation type names of this Segment in the pull down menu. Select any item from this menu will update the **Mod selected** menu with MODs available for the selected Operation. Once a MOD selected, the **Mods for** window will change to fit the MOD application. In the **Mod Value** panel a scroll bar and a text box allows user to set a MOD value for the MOD. In the **Operations/Time-series** panel, Operation names can be selected. In the **Mod Dates** panel, MOD dates could be available for user to change. The user can select on a text box by click on it, then click left and right button or use keyboard to change the MOD date. In the **Time-series Dates** panel a list of time series allows user to select for the MOD. In the **Options** panel the user can select **SEGMENT**, **FGROUP** or **RANGE** for the MOD. In the **Display** panel the user can toggle the **Show Mods Viewer** button to open or close the **Mods Viewer** window. The user can toggle the **Show Plot** button to open or close the **Mod Plot** window. The **Create** button will create a MOD for the selected MOD if an exact one not exist and the MOD information is valid. A message will pop up to inform user if new MOD cannot be created. All new MODs can be found in the **Show Mods Viewer** window. The **Close** button will close the Mods for window. The **Undo, Preferences** and **Help** button are reserved for future usage.

If the user goes on to another MOD without saving the current one then a warning pop-up provides another chance to save the current MOD before moving on (Figure 53 [Bookmark]).

**Available MODs**

The following MODs are available:

- **AEICQN**: Changes the Antecedent Evaporation Index (AEI) value in API Operations [Hyperlink]
- **AESCCHNG**: Changes the value of the areal extent of snow cover for SNOW-17 Operations [Hyperlink]
- **AIADJ**: Changes the AI adjustment factor for API Operations [Hyperlink]
- **APICBASF**: Multiplies the baseflow runoff from Operation API-CONT by a constant [Hyperlink]
- **APICQN**: Changes the API value in event API Operations [Hyperlink]
**BASEF**: Changes the recessing baseflow amount in baseflow Operations (value entered as flow) [Hyperlink]

**BFRCHNG**: Changes the recession factor for baseflow Operations with a single recession factor [Hyperlink]

**CBASEF**: Changes the constant baseflow amount for baseflow Operations (value entered as flow) [Hyperlink]

**CHGBLEND**: Changes the length of blending period in Operation ADJUST-Q [Hyperlink]

**IGNORETS**: Sets which types of data are to be ignored by Operations ADJUST-Q or RES-SNGL [Hyperlink] (Figure 51 [Bookmark])

**MFC**: Changes the melt factor correction value for Operation SNOW-17 [Hyperlink]

**RAINSNOW**: Sets whether precipitation during a period is rain or snow [Hyperlink]

The window for this MOD has a scrolled list of dates for with the MOD will apply. (Figure 52 [Bookmark])

**ROCHNG**: Changes the runoff values just before a unit hydrograph Operation [Hyperlink]

The initial ROCHNG MOD window has a button labeled Plot. When first choosing the ROCHNG MOD the Plot button is automatically depressed and a plot of the unit hydrograph ordinates appears. Values can be changed by selecting the label button and then clicking and moving the ordinates on the plot. See Figure 62 [Bookmark].

**ROMULT**: Multiplies runoff values by a constant just before a unit hydrograph Operation [Hyperlink]

**RRICHNG**: Changes the moisture input time series to a rainfall/runoff model [Hyperlink]

The initial RRICHNG MOD window has a button labeled Plot enabled. When first choosing the RRICHNG MOD the Plot button is automatically depressed and a plot of the unit hydrograph ordinates appears. Values can be changed by selecting the label button and then clicking and moving the ordinates on the plot. See Figure 63 [Bookmark].

**RRIMULT**: Multiplies the moisture input time series to a rainfall/runoff model by a specified value [Hyperlink]

**SACBASEF**: Multiplies the Operation SAC-SMA baseflow runoff by a constant [Hyperlink] (Figure 49 [Bookmark])

**SACCO**: Changes the SAC-SMA soil moisture carryover values
A **SACCO** MOD with only the changed values is created. The start MOD date is modifiable and Operation name is selectable in the Mods for window (Figure 44 [Bookmark]).

**SETMSNG:** Sets values in a time series to missing [Hyperlink]

**SETQMEAN:** Overrides rules specified in Operation RES-SNGL with mean flow values entered [Hyperlink]

The initial **SETQMEAN** MOD window has a button labeled **Enter Flows** which must be selected to allow entry of values (Figure 56 [Bookmark]). The value entry window allows the user to type in flow values, pressing Enter or selecting the Next button to move to the next value (Figure 57 [Bookmark]). Multiple values can be entered as shown in Figure 58 [Bookmark]. The values entered are converted into entries in the values list (Figure 59 [Bookmark]).

**SWITCHTS:** Indicates that the secondary time series defined for a MERGE-TS Operation to be used as input [Hyperlink]

**UADJ:** Multiplies the average wind function adjustment (UADJ) parameter for Operation SNOW-17 [Hyperlink]

**UHGCDATE:** Changes the ordinates of a unit hydrograph for a specified part of the run period [Hyperlink] (Figure 55a [Bookmark] and Figure 55b [Bookmark])

Additional information about this MOD follows [Bookmark].

**UHGCHNG:** Changes the ordinates of a unit hydrograph for the entire run period [Hyperlink]

The initial **UHGCHNG** MOD template has a button labeled Plot. When first choosing the **UHGCHNG** MOD the Plot button is automatically depressed for you and a plot of the unit hydrograph ordinates appears (Figure 54 [Bookmark]). Values can be changed by selecting the label button and then clicking and moving the ordinates on the plot. In the case shown in Figure 55 [Bookmark] the user has adjusted the unit hydrograph for the current storm because the major concentration of rain was near the basin outlet, so the time to peak of the unit hydrograph should be decreased. The ordinates of the unit hydrograph are re-scaled so the volume is conserved.

**WEADD:** Adds the value of snow water equivalent for a specified date [Hyperlink]

**WECHNG:** Changes the value of snow water equivalent for a specified date [Hyperlink]

**ZERODIFF:** resets the carryover in Operation ADJUST-Q at the start of
Additional Information About MOD UHGCDATE [Back]

MOD UHGCDATE allows the user to change values in the unit hydrograph in a similar manner to MOD UHGCHNG. MOD UHGCHNG allows the user to change values in the unit hydrograph for the entire period of the run. MOD UHGCDATE MOD allows the user change values of the unit hydrograph for a specified period of time by entering a start date, end date and valid date.

The following is the interaction of the UHGCDATE and UHGCHNG MODs:
- If there are multiple UHGCDATE MODs of the same time then the last MOD is used.
- If there are multiple UHGCHNG MODs of the same time then last MOD is used.
- If there are UHGCDATE and UHGCHNG MODs for the same time then the UHGCDATE MOD is used.

The MOD window is displayed when the UHGCDATE is selected from the Other mods menu. All the current UHGCDATE MODs are displayed in the Time-series Dates window. This window displays a scrollable list of start dates, end dates and valid dates for all the UHGCDATE MODs and the latest UHGCHNG MOD that had been made. The list of dates are sorted in a chronological order. The latest MOD is highlighted. A sample list would be:

```
Base
Default
04039312Z 04079312Z 04029312Z
04059312Z 04069312Z 04029312Z
03299312Z 04039312Z 04029312Z
```

where Base is a base unit hydrograph
Default is the start date and end date of the previous UHGCHNG mod

The start run and end run are used and the base unit hydrograph is displayed if there was no previous UHGCHNG MOD created.

To create a UHGCDATE MOD:
- Select the appropriate dates for the MOD from the Mod Dates panel. The dates can be entered by typing the date in the date boxes or using the arrow keys to change the date.
- Move the cursor to the date for which the ordinates are to be changed and double click to see the selected MOD information in the Mod Plot window. A new MOD can be created or an old MOD can be changed.

UHGCDATE MODs can be made with a selection of Operation names. For example the Operation names ROSSE and ROSSEB are used for the following MODs:
The toggle on/off (Segment name) button can be used for editing the UHGCDATE MOD. The unit hydrograph is displayed as a bar chart of the ordinates with time steps on the X axis and flow/runoff on the Y axis.

- Select the locations in the graph for the new ordinates.
- Select **done** to close the window.
- Select **done** to create UHGCDATE MOD. For example, the new UHGCDATE MOD will be created in the Mod Viewer window as:

```
.UHGCDATE 04039312Z 04069312Z 04029312Z
BLRSW .10 .23 .23 .41 .55 .65 .76 .50 .30 .20
```

- Select **undo** to cancel all changes.

Once the UHGCDATE MOD is created its value can be seen on **Mod Viewer** window.

Select **rerun** to see the affects of the UHGCDATE MOD on the Plot-Tulsa Operation.

**Selecting a Segment to Run**

Typically the user will proceed through a cycle of making adjustments to a Segment, rerunning and then moving to the next Segment downstream. There may be times when the user will want to process some intermediate forecast points without seeing the Tulsa plot display or making adjustments. Or there may be times when they will want to go back to an upstream Segment to make adjustments based on information seen in the current Segment. In either case the user can select in the forecast point schematic or on the geographic display, the Segment to go to and then select **Go to segment** in the IFP_Map **File** menu. If the Segment to go to is downstream of the current one, all intermediate points will be computed but no Tulsa plots will be displayed until reaching the selected Segment. If the Segment to go to is upstream of the current one, it will be the next one computed and its Tulsa plot displayed.

When the user is finished with an IFP session the **Quit** entry in the IFP_Map **File** menu will begin the IFP shutdown process. First a pop-up will appear asking if the user wants to send the MODs generated during this session to the OFS files so they will affect save carryover and other runs (Figure 60 [Bookmark]). If finished with that Forecast Group then **Yes** should be selected. If not finished or the MODS are not to be sent then choose **No** so that MODs are not transferred at this time. They do remain available for later use.
If MODs are sent to the OFS then a subsequent pop-up will appear telling the user that additional processing is happening to merge the MODs into a single file and transfer it to the OFS files (Figure 61 [Bookmark]). A batch OFS run is then automatically initiated to incorporate the new MODs into the operational files so the updated time series and MODs are available to the next user who copies the files.

Graphical Displays of Parametric and Time Series Data

SAC Display window:

The SAC display is a graphical display for Operation SAC-SMA [Hyperlink] data (Figure 45 [Bookmark#2]).

The SAC display window contains the window title, the Actions menu bar and the charts area.

The window tile consists of the display title and the Segment name.

The Actions menu has the following options:

1. **Change Model** will bring up a Model Selection window that contains a choice box for the available models or Operations and Okay and Cancel buttons. To select the new model, press the left mouse button while the pointer is over the choice box, select the Operation name of the desired model and release the button and then click Okay. The Model Selection window will close and refresh the display window with the selected model data.

2. **Cancel** will close the Model Selection window and no changes will be made to the display window.

3. **Refresh** will reset the display window to show any changes that may have occurred on the display.

4. **Close** or **Exit** will close the display window.

The charts area is the main data display area. It provides 5 plots. The top plot is a plot of the runoff components and the other plots are of the state variables.

Snow Display window:

The SAC display is a graphical display for Operation SNOW-17 [Hyperlink] data (Figure 46 [Bookmark#2]).

The SNOW display window contains the window title, the Actions menu bar and the charts area.

The window title contains the display title, the Segment name, the Operation name and dates.

The Actions menu bar allows user to select variety of options such as: Change Model, Open Model, Refresh, Close and Exit. All of these options work like the SAC display window.
The charts area is the main display area. It plots 4 different types of data:
1. snowpack energy exchange
2. precipitation type
3. areal water equivalent
4. simulated and observed snow components

**Plot-TS Display window:**

The Plot-TS display is a graphical display for time series (Figure 47a).

The main window display contains the title plotting area. The title includes the Operation name, Segment name and Operation description.

The plotting area is the main graphical display for time series. A maximum of 6 plots with a maximum of 10 time series on each plot can be displayed. All of time series in a single plot must have the same data units. The left Y axis displays time series units and the right hand Y axis displays the time series titles. The time series are plotted with time step on the X axis. To make changes to time series click on the time series tiles on the right hand side of the Plot-TS display window. When color of the title changing from any color to white then the time series is in the edit mode and changes can be made. Click on the time series title again to accept the changes or click on **Undo** to not accept the changes. If the changes are accepted then the data will be re-plotted. One time series can be changed at a time on a single plot. The modified time series will be written to a file and can be viewed by clicking on IFP Mod viewer window.
Figure 1a
Figure 1b

PROTEUS/NWSRFS
Interactive Forecast Program

<table>
<thead>
<tr>
<th>Forecast Group</th>
<th>Carryover Group</th>
<th>Carryover dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>NMWT</td>
<td>TUL</td>
<td>Apr 7, 1993 7, CDT</td>
</tr>
<tr>
<td>COKS</td>
<td>TUL</td>
<td>May 2, 1993 7, CDT</td>
</tr>
<tr>
<td>HAVARK</td>
<td>TUL</td>
<td>May 3, 1993 7, CDT</td>
</tr>
<tr>
<td>KEYINF</td>
<td>TUL</td>
<td>May 4, 1993 7, CDT</td>
</tr>
<tr>
<td>VERDNEO</td>
<td>TUL</td>
<td>May 5, 1993 7, CDT</td>
</tr>
<tr>
<td>EUFINF</td>
<td>TUL</td>
<td>May 6, 1993 7, CDT</td>
</tr>
<tr>
<td>KEYWEBB</td>
<td>TUL</td>
<td>May 7, 1993 7, CDT</td>
</tr>
<tr>
<td>KERRPB</td>
<td>TUL</td>
<td>May 8, 1993 7, CDT</td>
</tr>
<tr>
<td>WASHITA</td>
<td>TUL</td>
<td>May 9, 1993 7, CDT</td>
</tr>
<tr>
<td>DENINF</td>
<td>TUL</td>
<td>May 10, 1993 7, CDT</td>
</tr>
<tr>
<td>ARCFUL</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>WASHITAX</td>
<td>Special</td>
<td></td>
</tr>
</tbody>
</table>

Use copy of current OFS files

Load    Cancel    Help
Figure 2
Figure 3

[Diagram of EUFINF]

Figure 4

[Diagram of software interface with file and options menus]

Figure 5

NWSRFS Forecast Component is running. Please wait...
Figure 7

PROTEUS/NWSRFS Interactive Forecast Program

<table>
<thead>
<tr>
<th>Forecast Group</th>
<th>Carryover Group</th>
<th>Carryover dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>NMWTX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>COLRADOX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>WKANSASX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>HAVARKX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>KEYINFX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>VERDNEOX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>EUNINFX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>KEYWEBBX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>KERRPBFX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>WASHITAX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>DENINFX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>ARCELUX</td>
<td>TULX</td>
<td></td>
</tr>
</tbody>
</table>

Use copy of current OFS files

[Load] [Cancel] [Help]
Figure 8

PROTEUS/NWSRFS Interactive Forecast Program

Forecast Group

<table>
<thead>
<tr>
<th>Forecast Group</th>
<th>Carryover Group</th>
<th>Carryover dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>NMWTX</td>
<td>TULX</td>
<td>Feb 20, 1994 6, CST</td>
</tr>
<tr>
<td>COLRADOX</td>
<td>TULX</td>
<td>Mar 13, 1994 6, CST</td>
</tr>
<tr>
<td>WKAHSA</td>
<td>TULX</td>
<td>Mar 14, 1994 6, CST</td>
</tr>
<tr>
<td>HAVARKX</td>
<td>TULX</td>
<td>Mar 15, 1994 6, CST</td>
</tr>
<tr>
<td>KEYIFX</td>
<td>TULX</td>
<td>Mar 16, 1994 6, CST</td>
</tr>
<tr>
<td>VERDNEO</td>
<td>TULX</td>
<td>Mar 17, 1994 6, CST</td>
</tr>
<tr>
<td>EUNFINX</td>
<td>TULX</td>
<td>Mar 18, 1994 6, CST</td>
</tr>
<tr>
<td>KEYWEBB</td>
<td>TULX</td>
<td>Mar 19, 1994 6, CST</td>
</tr>
<tr>
<td>KERRPB</td>
<td>TULX</td>
<td>Mar 20, 1994 6, CST</td>
</tr>
<tr>
<td>WASHITAX</td>
<td>TULX</td>
<td>Mar 21, 1994 6, CST</td>
</tr>
<tr>
<td>DENINFX</td>
<td>TULX</td>
<td></td>
</tr>
<tr>
<td>ARCELUX</td>
<td>TULX</td>
<td></td>
</tr>
</tbody>
</table>

Use copy of current OFS files

Load  Cancel  Help
Figure 9

PROTEUS/NWSRFS
Interactive Forecast Program

Forecast Group | Carryover Group | Carryover dates
---------------|----------------|------------------
NMWTX         | TULX           | Feb 20, 1994 6, CST
COLRADOX      | TULX           | Mar 13, 1994 6, CST
WKANSASX      | TULX           | Mar 14, 1994 6, CST
HAVARKX       | TULX           | Mar 15, 1994 6, CST
KEYINFX       | TULX           | Mar 16, 1994 6, CST
VERDNEOX      | TULX           | Mar 17, 1994 6, CST
EUFINFX       | TULX           | Mar 18, 1994 6, CST
KEYWEBBX      | TULX           | Mar 19, 1994 6, CST
KERRPBFX      | TULX           | Mar 20, 1994 6, CST
WASHITAX      | TULX           | Mar 21, 1994 6, CST
DENINFX       | TULX           |                 
ARCELUX       | TULX           |                 

Use copy of current OFS files
Use previous IFP files
Load  Cancel  Help
A Forecast Group and Carryover date must be selected before NWSRFS can begin execution. Selecting 'Load' will read data files corresponding to the selected Forecast Group and Carryover date, and the selection window will pop down.

Also, here are options for selecting the data to be used in the NWSRFS-IFP runs:

The differences between them are how current the data are; the most recent data resides in the NWSRFS OFS files database, but since certain data do not change appreciably over time - such as segment definitions - it is not necessary to update these data at the beginning of each forecast run. However, at the beginning of each day it should be necessary to update time-series & carryover data from the NWSRFS OFS file database by selecting 'Use copy of current OFS files'.

With subsequent forecast runs during a day, data stored on the workstation should be sufficient... the default is to use previously used time-series & carryover data from the previously existing IFP files located in:

$HOME/ofsp_ifp/fs5files/

RFC Schematic
Saving changes when deleting Mods
Saving Run-time Mods
Selecting Forecast Groups & Carryover
Setting Non-universal Techniques
Setting Run dates
Setting Universal Techniques
Writing Run-time Mods to a file
PROTEUS/NWSRFS
Interactive Forecast Program

Selecting LOAD will set up the data files that are needed to run NWSRFS–IFP for the selected Forecast Group and Carryover date. These data cannot be loaded without selections of both a Forecast Group and Carryover date.

Use copy of current OFS files

Load  Cancel  Help
Figure 12

Please wait while files are being initialized for NWSRFS-IFP...

Figure 13

File Options Display Modifications Help
Begin Ctrl+B
Rerun Ctrl+R
Next Ctrl+N
Continue

Go to segment

New Forecast Group... Ctrl+T
Quit Ctrl+Q
Figure 15

Figure 16
Figure 17

Figure 18

Segment: DRGSW

<table>
<thead>
<tr>
<th>Forecast Point:</th>
<th>DRGSW</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description:</td>
<td>COPPER FK @ DURANGO</td>
</tr>
<tr>
<td>River name:</td>
<td>COPPER FK-TEXORADO</td>
</tr>
<tr>
<td>Station name:</td>
<td>DURANGO</td>
</tr>
<tr>
<td>Carryover group:</td>
<td>TEX</td>
</tr>
<tr>
<td>Upstream segments:</td>
<td>None</td>
</tr>
<tr>
<td>Downstream segments:</td>
<td>DDCSW</td>
</tr>
<tr>
<td>Latitude (degrees):</td>
<td>40.30</td>
</tr>
<tr>
<td>Longitude (degrees):</td>
<td>107.21</td>
</tr>
<tr>
<td>Type of forecast point:</td>
<td>86UP</td>
</tr>
<tr>
<td>Forecast point area (sq mi):</td>
<td>370</td>
</tr>
<tr>
<td>Total area above forecast point (sq mi):</td>
<td>370</td>
</tr>
<tr>
<td>Flood stage (ft):</td>
<td>8.88</td>
</tr>
<tr>
<td>Flood flow (cfs):</td>
<td>6533</td>
</tr>
<tr>
<td>Secondary stage (ft):</td>
<td>Missing</td>
</tr>
<tr>
<td>Alert stage (ft):</td>
<td>Missing</td>
</tr>
<tr>
<td>Alert flow (cfs):</td>
<td>5227</td>
</tr>
<tr>
<td>Gage zero (ft):</td>
<td>2770</td>
</tr>
<tr>
<td>Record flood stage (ft):</td>
<td>11.15</td>
</tr>
<tr>
<td>Record flood flow (cfs):</td>
<td>13384</td>
</tr>
<tr>
<td>Date of record flood:</td>
<td>October 5, 1910</td>
</tr>
<tr>
<td>Comment about record flood:</td>
<td>AVG PCP 3.5-4.5</td>
</tr>
<tr>
<td>Upper limit of rating curve (ft):</td>
<td>10</td>
</tr>
</tbody>
</table>

Close
Figure 19

Figure 20
Figure 21

Universal Techniques

Time Zone
- Input:
  - Standard: EST, CST, MST, PST, AST, HST, NST
  - Daylight Savings: EST, CST, MST, PST, AST, HST, NST
- Z
- Mods: Z

Units
- General:
  - English, Metric
- Run-time Modifications:
  - English, Metric
  - General, SAC, API

Miscellaneous
- Future Precipitation
- Mods Warning

Set | Cancel | Help

Figure 22

Snow Model Techniques

<table>
<thead>
<tr>
<th>Technique</th>
<th>On</th>
<th>Off</th>
<th>No Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snow</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frost</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UPSC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UPWE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAC/SNOW STATE</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Segments
- Apply to:
  - All, Selected

Apply | Cancel | Help

BLR Southwest
DRG Southwest
DDCSW
SPESW
ILSSW
LSMSW
GSMSW
GLMSW
HATS
HATS
GLFSW

12/20/2004 VI.5.4-IFP-33 rfs:654ifp.wpd
Figure 25

Figure 26

Contains commands which show and hide windows for generating Run-time modifications and showing the results of NWSRFS execution.
Figure 41

Set time series Mods keywords

Operations
Type    Name
LAG/K    TRLK1
CLEAR-TS TRLK1
ADD/SUB  ATOK1
SNOW-17  ATOK1
SAC-SMA  ATOK1
CLEAR-TS ATOK1
UNIT-HG   ATOK1
CLEAR-TS  ATOK1
ADD/SUB   ROUTED
ADD/SUB   LOCAL
STAGE-Q   ATOK1
ADJUST-Q  ATOK1
STAGE-Q   ATOK1
PLOT-TUL  ATOK1

Time Series  Keyword

[Back] [Next] [Previous] [Bookmarks] [Top]

Figure 42

Modifications

- Tulsa plot   Ctrl + T
- Time-series table  Ctrl + E
- Other mods       Ctrl + M

12/20/2004   VI.5.4-IFP-48   rfs:654ifp.wpd
Figure 43

Figure 44
Figure 49

Available Operations
Show Mods for ALL

Mod Value
1.000000
Dimensionless

Available Run-time Mods
Mod selected SACBASE

Operations/Time-series
Type / Name
SAC-SMA BRLG
SAC-SMA BRNL
SAC-SMA BRNU

Mod Dates
Start of Mod
Mar 29 1993 19Z

Time-series Dates
No DATE values for this Mod

Options
No options for this Mod
Apply to: SEGMENT

Display
Show Mods Viewer

Create Close Undo Preferences Help

Figure 50

[File Options Display Modifications Help]

[Back] [Next] [Previous] [Bookmarks] [Top]
Figure 51

Available Operations
Show Mods for: ALL

Available Run-time Mods
Mod selected: IGNORETS

Mod Value
No value entry for this Mod

Operations/Time-series
Type / Name
ADJUST-Q DARNC

Mod Dates
Start of Mod
Mar 29 1993 12 Z
End of Mod
Apr 3 1993 12 Z

Time-series Dates
No DATE values for this Mod

Options
Keyword: POOL
Apply to: SEGMENT

Display
☐ Show Mods Viewer

Create  Close  Undo  Preferences  Help
Figure 52

Available Operations
Show Mods for ALL

Available Run-time Mods
Mod selected RAINSNOW

Mod Value
No value entry for this Mod

Operations/Time-series
Type / Name
SNOW-17 DARNC

Mod Dates
No dates to change for this Mod

Time-series Dates
Mar 29 1993 18 Z
Mar 29 1993 24 Z
Mar 30 1993 6 Z
Mar 30 1993 12 Z
Mar 30 1993 18 Z
Mar 30 1993 24 Z
Mar 31 1993 6 Z
Mar 31 1993 12 Z
Mar 31 1993 18 Z
Mar 31 1993 24 Z

Options
Keyword: RAIN
Apply to: SEGMENT

Display
Show Mods Viewer

Create Close Undo Preferences Help

Figure 53

None of the data have been saved for the current ROMULT run-time mod. Do you wish to save data for this mod?

Yes No Help
Figure 55a
Figure 57

<table>
<thead>
<tr>
<th>Dates</th>
<th>Discharge</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mar 29 1993 12 Z</td>
<td>8700.0</td>
</tr>
<tr>
<td>Mar 29 1993 18 Z</td>
<td>8750.0</td>
</tr>
<tr>
<td>Dates</td>
<td>Discharge</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Mar 29 1993 12 Z</td>
<td>8700.0</td>
</tr>
<tr>
<td>Mar 29 1993 18 Z</td>
<td>8750.0</td>
</tr>
<tr>
<td>Mar 29 1993 24 Z</td>
<td>9000.0</td>
</tr>
<tr>
<td>Mar 30 1993 6 Z</td>
<td>9050.0</td>
</tr>
<tr>
<td>Mar 30 1993 12 Z</td>
<td>8900.0</td>
</tr>
<tr>
<td>Mar 30 1993 18 Z</td>
<td>8875.0</td>
</tr>
<tr>
<td>Mar 30 1993 24 Z</td>
<td>9000.0</td>
</tr>
<tr>
<td>Mar 31 1993 6 Z</td>
<td>9050.0</td>
</tr>
<tr>
<td>Mar 31 1993 12 Z</td>
<td>8900.0</td>
</tr>
<tr>
<td>Mar 31 1993 18 Z</td>
<td>8875.0</td>
</tr>
</tbody>
</table>
Figure 60

You are about to end the NWSRFS IFP.
Do you want to send the new Run-time Modifications to the OFS?

[Yes] [No] [Cancel]

Figure 61

Run-time Mods for forecast group VERDNEO are being combined into one file for transfer to the OFS.

Figure 62

[Back] [Next] [Previous] [Bookmarks] [Top]